
 

Getting Started with 

SHOWCASE® 
 

Thank you for using ShowCase for your medical imaging needs.  

This guide will help you and your team get started using your ShowCase 

software effectively and efficiently.  
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Before You Begin Using ShowCase 
 
ShowCase Viewer:  ShowCase Premier, ShowCase Workstation and ShowCase Basic are DICOM 
medical image viewers. ShowCase Premier and Workstation can be connected to the ShowCase 
Image Center study management product. ShowCase Premier and Workstation comes with the 
ShowCase Portable Viewer, a limited-feature viewer that exports from ShowCase Premier to a CD, 
DVD or USB flash drive and displays the studies on the disc or flash drive on Windows© computers. 
ShowCase Workstation can Query/Retrieve from PACS and Send studies to PACS. It can also be 
configured to automatically forward studies to PACS or an Image Center. 
 
Hardware:  The ShowCase viewers and ShowCase Image Center run under 10, 11 and Server 2012R2, 

2016, 2019, 2022 on 64-bit hardware and virtual machines. 

License:  Use of any ShowCase product is subject to the license agreed to when running the software 
installers. The viewer license text is provided at the end of this guide. 
 
 

 

Regulatory Information 
ShowCase viewing software has received US FDA clearance as a Class II Medical 
Device; The K number is K082135. The intended use statement reads  
“ShowCase is diagnostic quality radiological viewing software. ShowCase can 
be used to receive, store, display and manipulate medical images and 
associated clinical data.” 
 

 
DICOM Conformance Statement: The latest DICOM Conformance Statement is always available on 
the Trillium Technology web site, www.triltech.com . The ShowCase Image Center is a DICOM Image 
Store Service Class Provider (SCP). The ShowCase Workstation is a DICOM Image Store Service Class 
Provider (SCP) and a DICOM Service Class User (SCU). 
 
ShowCase Support:  We offer two support plans: Standard Support (email only, business hours 
Eastern US Time) and Priority Support (email, phone, remote desktop, extended hours). Support 
plans are billed annually. Support for licensing issues is available regardless of your plan status, as is 
the FAQ and documentation our web site: http://www.triltech.com. While a support plan is not 
required for your ShowCase products to run, we generally recommend that all customers maintain at 
least Standard Support. 
 
 
 
 
 
 

 
SHOWCASE is a trademark registered in the U.S. Patent office by Trillium Technology, Inc.  Windows is a 
registered trademark of Microsoft Corporation. All other trademarks are trademarks or registered trademarks 
of their respective holders. 

http://www.triltech.com/
http://www.triltech.com/
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Image Viewing  

ShowCase viewers have a set of preferences you can access from the Edit Menu. You may want to 
customize the way images display on your viewing computers.  

To set your default viewing sizes and other behaviors… 

Select the Edit Menu, ShowCase Settings… item and click the Viewer tab to set the default viewing 
behavior on your computer.  

 

Each Modality has its own settings, which allow you to control your default screen layout, double-
click behavior and a variety of other default behaviors for that modality. 

Accessing the studies you want to view will depend on where your studies are stored. 

To select a study from a ShowCase Image Center 

If your site uses a ShowCase Image Center to manage your studies, you will normally select 
studies from the Image Center tab of your ShowCase Study Lists window. Click on the tab that has 
the color Image Center icon (spiral) and if necessary, Search for the study, select it and click the 
Show button (or double-click on the study).  
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If you need to find a study in your Image Center, click on the Search button and fill in criteria for a 
new study list filtered by date, patient name, ID, study description, modality or referring 
physician.     

 

To select a study from a CD, DVD or USB flash drive 

When you start ShowCase, the software looks at all “volumes” on your computer to see which 

include a DICOM Directory at the root level. ShowCase should find all DICOM formatted CDs, 

DVDs or USB flash drives that are inserted in your machine. (Note: when you first insert a new CD 

or DVD you may need to wait a few seconds until it is recognized.). Each DICOM volume available 

on your machine appears on a tab. Click on the tab for the Study List you wish to view.  

  

 

To select individual image files in DICOM format 

If you have DICOM formatted images that are not organized on a DICOM disk with a directory, 
you can still view them using the Browse button, which you will find in the upper right corner of 
the Study List. Use the Browse button to point to a folder full of files to view. Or use the File Menu 
=> Open => Dicom File or File Menu => Open => Dicom Folder options.  

 

 

Navigating through the images in a study  

You can use the scroll wheel on your mouse or position the vertical scroll bar to move through the 

images. Or you can use the keyboard arrow keys to step through rows of images, ‘Page Up’ & 

‘Page Down’ keys to step through pages of images and the Home and End keys to jump to the 

beginning and end of the study.  

Tip:  You can stop and start clips by right clicking on the clip.  To start all clips playing, click on the 

play button  in the upper right corner. 
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To select a new study  

 

When you have finished looking at a study and want to move to a new study, close 
the study by clicking on the close box in the upper right corner, or by selecting the 
menu item File: Close. Or if you want more than one study displayed, click on the 
Study List button to select another patient study or series of images.  

   

 Navigating through multiple study displays.   

 

If you have more than one image window open, you can navigate through the 
windows by using the Next and Prev buttons at the top of the screen.  

 

You can view two studies next to each other in a compare mode. Click on the Window menu to 

select a layout. You can compare left/right or top/bottom.  

           

 

 

To reset image contrast and brightness     

Double-click on the image and select the ‘Contrast/Brightness’ tab to readjust the window, level, 
or gamma correction as desired. If you export an image (AVI or BMP for example) the exported 
image will keep the contrast settings. To apply the same settings to all of the images in the series, 
check the “Apply to All” button.  
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To change the size of displayed images    

 

 

To change the size of the images you are displaying, use the toolbar 
size drop-down to select a new viewing size. 

Or click F7.  

You can use the F9 function key to toggle between “One Up 
Autoplay” and Thumbnails. 

Use One-up Autoplay to step thru images one at a time. 

Double-click on the image to view it at full acquired resolution and 
access imaging tools. 

 

 

 

A Note About Clip Playback 

ShowCase makes every effort to play back clips at the clip playback speed set by the imaging device 

and stored in the DICOM image file. If your computer’s hardware is having difficulty maintaining the 

specified frame rate, it is possible that frames will be dropped. If this occurs, a flashing indicator will 

appear. If your hardware meets the specifications designated in the ShowCase Hardware 

Requirements, it is very unlikely you will ever encounter this condition. 

 

ShowCase Quick Guides that might help you with some additional imaging tasks 

include -  

Burning CDs/DVDs/USBs With Portable DICOM Viewer 

De-identifying Studies 

Exporting Images to PowerPoint 

Making Measurements 

Structured Reports 

 

Download the Quick Guides from https://www.triltech.com/documents.html.  
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Handy Keyboard Shortcuts for Quicker Image Viewing 

 

Key(s) Action 

Scroll wheel Use the scroll wheel on your mouse to scroll 

thru the images in a series, or thru the list of 

studies in a study list. 

Right-click Start/stop a clip playback 

Double-click Open the full size image window and access 

brightness & contrast, annotation tools, paint-

out tools and image measurement tools. 

Ctrl-A Select All images 

Ctrl-B Browse to a folder of images 

Ctrl-O Open Directories Window to select a new study 

Ctrl-P Print the current series of images 

F7 Move to the next image display size (cycles thru 

all sizes thumbnail to full screen) 

F9 Toggle to/from “one-up auto-play” mode 

Pg Up Scroll to the next screen of images 

Pg Down Scroll to the previous screen of images 

Home Scroll to the first image in the series 

End Scroll to the last image in the series 

 (up arrow) Scroll up one row of images 

 (down arrow) Scroll down one row of images 
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SHOWCASE VIEWER END USER AGREEMENT 

This End User Agreement (“Agreement”) by and between Trillium Technology, Inc., with a place of business in 

Ann Arbor, Michigan U.S.A. (“Trillium”) and you (“User”) states the terms and conditions under which the User 

may use the SHOWCASE software (the “Software”). Please read this Agreement carefully before accessing and 

using the Software. By using and accessing the Software, and by clicking the button that represents your 

agreement with this license, you indicate that you have read and understand this Agreement and that you are 

and agree to be bound to this Agreement. If you do not accept this Agreement, cancel this installation and 

neither access nor use the Software. 

 
THE NATURAL PERSON CLICKING THE BUTTON INDICATING AGREEMENT REPRESENTS AND WARRANTS ON 
BEHALF OF USER THAT S/HE IS AUTHORIZED TO SIGN CONTRACTS ON BEHALF OF, AND TO THEREBY BIND, 
USER. 

1. ARTICLE 1.  CONDITIONS OF USE 

1.1 License.  Subject to the terms of this Agreement, Trillium grants to User the right to use and perform 
the Software for User’s internal business use only. For each FIXED (Internet or manually activated) license 
acquired, the foregoing license authorizes the installation of one copy of the Software on a single computer, 
provided that the primary user of a computer on which a copy of the Software is installed may make a second 
copy for his or her exclusive use on either a home or portable computer. User may not disassemble, decompile, 
reverse engineer, or otherwise translate the Software or any portion thereof, nor may User permit or encourage 
any of the foregoing. User may use the User's Guide, including all updates thereto ("Documentation") only in 
connection with User’s use of the Software hereunder. The rights granted herein do not include the right to 
sublicense. 

1.2 Dongles. If User has received a hardware key (“Dongle”) from Trillium, User is authorized to make 
copies of the Software on computers within User’s possession and control. User shall not, and shall not 
attempt to, duplicate, replicate, reverse engineer, disassemble, or circumvent any Dongle provided to User. In 
the event that User damages a Dongle, it may return the Dongle to Trillium for repair or replacement (in 
Trillium’s sole discretion), subject to Trillium’s then-current payment terms.  In the event that User declares a 
Dongle lost, then Trillium will replace the Dongle upon User’s payment of Trillium’s then-current portable 
license fee, which amount is non-refundable in the event that User later recovers the initial Dongle. 

1.3 Fees.  Amounts paid by User in connection with the Software are non-refundable.   

2. ARTICLE 2.  INTELLECTUAL PROPERTY 

2.1 Ownership and Title.   Other than limited portions of the Software performed, distributed, and 
reproduced under license from Glyph & Cog, LLC, User agrees and acknowledges that Trillium owns all right, title 
and interest in and to the Software, Documentation and all intellectual property therein, and that User will not 
obtain or claim any ownership interest in the Software or Documentation, or any portion thereof, or any 
intellectual property therein. User agrees and acknowledges that the Software and Documentation contain the 
valuable trade secrets and proprietary information of Trillium, which have been developed at great expense over 
many years. User will not obscure, alter or remove any patent, copyright, trademark, service mark or other 
marking or legend contained on or in any Software or Documentation. User will ensure that no unauthorized 
persons have access to the Software, and that no persons authorized to have such access will take any action in 
violation of this Agreement. SHOWCASE is a trademark owned by Trillium and registered with the U.S. Patent and 
Trademark Office (Reg. No. 2,728,082). 
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2.2 Confidentiality.  User hereby acknowledges that the Software and Documentation contain 
information that is trade secret and proprietary to Trillium. User hereby agrees not to disclose such information 
except to persons and organizations expressly authorized by Trillium to receive such information.  

2.3 Confidential Information.  User must keep all Trillium Confidential Information to which User has 
access in strict confidence. User may not disclose Confidential Information, except to persons authorized by 
Trillium.  

3. ARTICLE 3.  WARRANTY LIMITATION 

3.1 WARRANTY LIMITATION.  EXCEPT AS EXPRESSLY PROVIDED HEREIN THE SOFTWARE AND USER’S 
USE THEREOF IS PROVIDED "AS IS" WITHOUT WARRANTY, EXPRESS OR IMPLIED OF ANY KIND, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE OF THE SOFTWARE REMAINS WITH USER. IN NO 
EVENT WILL TRILLIUM BE LIABLE FOR ANY DAMAGE WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY 
TO ACCESS THE SOFTWARE OR TO USE THE SOFTWARE, EVEN IF TRILLIUM HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. TRILLIUM DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR FREE. USER ACKNOWLEDGES AND AGREES THAT USER HAS NOT RELIED 
ON ANY EXPRESS OR IMPLIED REPRESENTATION OF DISCREET, WRITTEN OR ORAL, AS AN INDUCEMENT TO 
ENTERING INTO THIS AGREEMENT.  Some jurisdictions do not allow limitation of certain warranties, so the 
above limitation may not apply to User. This limited warranty gives User specific legal rights.  

3.2 Indemnification.  User shall defend, indemnify and hold Trillium and its officers, directors, 
employees, and agents harmless from and against any and all threatened or actual claims, actions, liability, 
suits, expenses, costs, fees (including attorney’s fees), damages, or losses arising from or relating to (i) use of 
the Software by persons authorized by User; (ii) User’s acts (or any failure to act) hereunder; and (iii) any 
breach by User of User’s obligations hereunder. 

3.3 Limitation of Damages.  TRILLIUM SHALL NOT BE LIABLE TO USER UNDER THIS AGREEMENT OR IN 
CONNECTION WITH THE SOFTWARE FOR ANY PERSONAL INJURY, LOST PROFITS, CONSEQUENTIAL, 
EXEMPLARY, INCIDENTAL, OR PUNITIVE DAMAGES, REGARDLESS OF THE FORM OF ACTION, WHETHER IN 
CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, AND REGARDLESS OF WHETHER TRILLIUM HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES IN ADVANCE OR WHETHER SUCH DAMAGES ARE 
REASONABLY FORESEEABLE. NOTWITHSTANDING ANY PROVISION TO THE CONTRARY, THE LIABILITY OF 
TRILLIUM FOR ANY REASON AND FOR ANY CAUSE OF ACTION WHATSOEVER IN CONNECTION WITH THIS 
AGREEMENT AND THE SOFTWARE OR USER’S USE THEREOF SHALL NOT EXCEED AMOUNTS PAID TO TRILLIUM 
HEREUNDER.  

4. ARTICLE 4.  MISCELLANEOUS 

4.1 Term. This Agreement shall terminate immediately upon the earlier to occur of (i) User’s notice to 
Trillium; or (ii) User’s breach of the Agreement. Immediately upon termination, User shall destroy any copies 
of the Software, Dongles, or Documentation in User’s possession or control. Section 1.2, Section 1.3, and 
Articles 2, 3, and 4 shall survive the termination of this Agreement. 

4.2 Assignments.  All delegations, transfers or assignments of rights, duties or obligations under this 
Agreement by User without the prior written consent of Trillium shall be null, void and without effect.  

4.3 Restricted Rights. The Software and documentation are provided with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of 
The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, 227.7202-1(a) and 
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227.7202-3(a) or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 
CFR 12.212(a), or 52.227-14(41 & III), 52.227-19, as applicable.  

4.4 Entire Agreement.  This Agreement contains the entire understanding of the parties and 
supersedes previous verbal and written communications, proposals and agreements between the parties 
concerning the subject matter hereof.  

4.5 Amendments and Modifications.  Unless specifically provided in this Agreement, waivers, 
alterations, modifications or amendments of a provision of this Agreement shall not be binding unless such 
waiver, alteration, modification or amendment is in writing and signed by an authorized representative of both 
parties. 

4.6 Severability.  If a provision of this Agreement is rendered invalid, void or unlawful, the remaining 
provisions shall remain in full force and effect. 

4.7 Counterparts.  This Agreement may be executed in multiple counterparts, each of which shall be 
an original, but which together shall constitute one and the same instrument. 

4.8 Governing Law.  This Agreement shall be governed by the laws of the State of Michigan without 
regard to any rules of conflict or choice of laws. The parties consent to the exclusive jurisdiction of the state 
and federal courts in the Eastern District of Michigan with respect to all disputes arising from or related to this 
Agreement. 

4.9 Relationship of the Parties.  It is agreed that the relationship of the parties is primarily that of an 
independent contractor. Nothing herein shall be construed as creating a partnership, an employment 
relationship, or an agency relationship between the parties, or as authorizing either party to act as agent for 
the other. 

 


